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1 Live Camera Controls

All actions that relate to changes made to the cameras tab interface, and that involve the live viewing and
control of cameras.

a. Open or close a Cameras desktop

e Toopen a Cameras desktop

Option 1:
Just open the site (most sites are set to open at the Camera desktop by default):
> Open Site > [Sitename]

@; Enterprise manager
& Multi-site view
=i s - -

Option 2:
With the Site already opened, click > Open tab > Cameras
= catSite (1)

Option 3:

With the Site already opened, click File > [Sitename] > Open tab > Cameras

= catSite (1)
File Edit View Tools Settings Help

Open site 3
@. Enterprise manager
& Multi-site view
Archive viewer

S R - KT o oo

Option 4:
With the Site already opened, right-click any tab and select Open tab > Cameras:

File Edit View Site Tools Settings Help

Open tab
E----gdaa ﬁ Close site's tabs
5----§Test LEJ Change legin...
%@ Go offline

™
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e To close a Cameras desktop

Click theon the tab:
]ElTesth ® r

b. Main Screen Areas

File Edit View Site ngs Help

(& catcentuionsecurty 36 %catcerﬂuﬁonsecuﬂw W

S8 Matthew's Site. 3 |[&] Matthew's St 34 |

e E=

Resources
Cat Tech WMegting area [Zone 9

~(#)Cat Africa Storage Area VMD
() Cat Africa upstairs VMD
() Cat Tech 7 VMD

Cat Tech assembly 2 VMD
(®)Cat Tech downstairs 1 VMD =

=l

' #7 Notifications

No notfications

; E® 7Y

matt Administrator & Online

@ The menu bar provides menu options for the current desktop, and shows your access rights. These menu
options change as you tab between cameras and map desktops.

@ The desktop tabs are opened desktops such as maps or sites. Status indications by text colour:

File Edit View Site Map Tools Settings Help (& TesthVR “’ Efatiﬁglr'f?;e

(& TestNVR ﬁr Blue: Connecting

,ElTestNT' Green: Online But not
Current

Right-click a tab to see a menu for that tab/desktop.

Click n to Close a tab.

Theoretically you can have an unlimited number of tabs opened, whether maps or resources, but in
practice you will not be able to read the tab details.

Each Site can be custom-configured to automatically load certain desktops when a connection is made to
the Site (this is configured from File —>Enterprise Manager —> Right Click —> Properties).

@ The desktop forms the main area of the screen. Normally this is a cameras desktop.
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Camera controls are like VCR controls for the camera/s you have selected (indicated by a ).
Cameras can be viewed Live and Reviewed within the same interface. For example, simply click < to play a
Live camera backwards (if it has recordings).

This area also includes a button & for configuring the automated switching of screen displays (see pg 11):

B
§  Unlockdisplay “Lock display” prevents automate switching. “Unlock display” permits it.
I Settings...
@ = Resources l'_ | The panel selector is a dropdown bar for selecting panels:

The Resources panel provides a folder-hierarchy of resources for the entire enterprise. The setup
for these resources is highly customisable. Across the top of the panel is a rack of show-and-hide
buttons to simplify the display of resources.

(8 The Dome panel (pg 12) provides an intuitive, responsive software joystick.

"winel  The panel performs various functions, depending on the current selection from the
panel selector.

@ m The Local Resources bar (top right) shows the status of local hardware resources:

@ Local default audio input (e.g. your microphone) @ Local default audio output (e.g. your speakers)
Local monitor

When active, these resources display _, and when inactive they are grey. If you run your cursor
over an active resource, a “tooltip” will provide information on the activity (for example, mouseover a
green monitor to see what camera is displaying to that monitor).

If you have many local resources, they will be arranged in a scrolling area, with left and right scroll arrows.

e To hide and show resources in the resources panel

& @ Audon 1. Click the Filter button to display the Filter dialogue.

o 2. Select or de-select resources for display, and then click OK.
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If your administrator has set up Event Notifications for this unit then you will receive notifications based on

these setups.

47 Notifications

/" HEdge: Record Axis now

1 A Message Notification

HEdge: Record Axis
1/h35 at Matthew's Site  {now)

2 A Popup Notification

c. Live and Review Cameras

An audio notification. This is a sound clip that gets
played when the event triggers.

A message notification. This is a message that gets
displayed in the notification area of the resource panel.
It's meant as an unobtrusive feed of events (To show the
notifications area, click the ﬁ icon at the bottom of the
resource panel. This can be resized). If an event has
camera resources associated with it then the notification
can be double-clicked and the cameras will be shown in
the camera view.

A popup notification. This is a popup message box that is
shown when the event triggers.

Camera text overlays provide information. They can be hidden (middle-click>Hide text overlays).

Green text shows that the camera is Live.
Camera number / name (top left)

Date and Time at the live camera site
(bottom right)

ﬁ (green microphone icon) On a Live
remote MPEG camera with audio, audio
input status (green is active, grey is
inactive). This is at top left, before the
camera number / name. It displays with
MPEG, which has embedded audio.

Red text shows that the camera is being
reviewed (replayed) — it is not live.

Camera number / name (top left)

Date and Time of the current
image/frame (bottom right)

(Time display in CatVision is based on
base-station regional settings)

Speed and direction of replay (top right).

This relates to the speed slider bar setting
in the Camera Controls. It does not apply

for Live displays. For example,

x1.0 > is a camera being reviewed, playing
forward at 1x normal speed

x5.0 < is a camera being reviewed, playing
backward at 5x normal speed

d. Video wall of cameras with resources panel or menus (release 5042c2)

To display cameras as a video wall (only available from release 5042c2 onwards)

005-20120711-05 Rev 2
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Right-click a camera and

select “Cameras full To exit this mode, either

Press ESC, or Right-click >

screen” : ,.
“Exit full screen

No camera

No camera
Enlarge mandmum

Enlarge manamum
Reduce P
Resizepanel  » Resizepand  »

NOTE: In full screen mode, you can still resize, zoom, and drag within camera panels cameras.

005-20120711-05 Rev 2 www.cathexis.co.za Page 8
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e. Choose cameras to display

Double-click a camera in the Resources panel

Double-click a camera in the Resources panel to load it Live

é----@all Cameras
Y ads 1.3mp

into the camera panel that currently has focus (is ).

Drag a camera from the Resources panel

Left Click on a camera, holding down the
mouse button, and Drag a camera from the
Resources panel (first drag the camera
horizontally left, and then to the panel that
you want to view it in)

g----@all Cameras
Sy ads 1.3mp

Drag a group of cameras from the Resources panel

From release 5042c2, January 2011, you can select a group
of cameras from the resource pane and drag them onto
the camera display (for camera tab or multisite tab). This is
a quick and convenient way to populate a screen with
cameras.

é----@all Cameras

This is achieved by selecting cameras while holding down
the CTRL button on your keyboard, then Dragging them
across.

f. Digital Zoom
e Zoom in/out
Scroll the mouse wheel.

e Zoom to area

While holding the shift key, drag-select an area using the left mouse button

e Pan

Pan the image using the left mouse-button. This is done by holding down the left mouse button, while moving

the mouse.

g. Select, or Move, Camera Panels

e To select a panel with the mouse
Simply click the appropriate panel.
> Your clicked panel will then have

a , indicating that it is selected.

e To select a panel by means of the keypad

9 ; The keypad arrows will

Hnrw- move panel focus
Eﬂﬂ

i.e. they move the

e To select multiple cameras

1. Toggle selection using left-click with CTRL pressed

005-20120711-05 Rev 2

www.cathexis.co.za Page 9



http://www.cathexis.co.za/

2. Group selection using left-click with SHIFT pressed (click top-left, shift click botton right and the all

the panels should be selected)

e To select ALL cameras in the Cameras or Multisite desktop

Use CRL-A to select all of the visible cameras in the CatVision Cameras desktop and Multisite desktop.

This is useful to perform functions such as pausing all cameras on the screen.

File Edit View Site Layouts Tools Settings Help

= TestNVR

Mo camera

Wa«[alnlw »n ;-dﬂi

.
Soo s H k@)

Resources [

@ @is 1.3mp
®rTZ
(3 stairs
== database 2
=5 TestNVR2

® v

4y Offline

e Move a Camera Panel
To move a panel using right-click and drag.
e Copy a Panel
Copy a panel using right-click and drag, with CTRL pressed.

h. Resize a camera panel

e To resize camera panels by mouse-clicking

‘: Double left click to increase size. - -|] Right click to decrease size.

e To resize camera panels by floating controls

Hold your cursor top centre
o e =) | | |
of the image to display > ..and then click appropriately to resize.

these floating controls...
[ Enlarge | Reduce]

005-20120711-05 Rev 2 www.cathexis.co.za
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e To change panel size from the
keypad:

For the | selected camera panel |,

Press the keypad corner buttons to increase
size.

Hold the CTRL key and press the keypad corner J:El DJ\.
buttons to decrease size.

(TR

e To resize a panel from the middle-click menu:

1. % Middle-click the appropriate camera panel

> The middle-click menu displays...

MO camera

2. — Enlarge: Enlarges one step
Enlarge maximum Enlarge maximum: Enlarges to fill the camera displays.
Reduce

Resize panel

-

Reduce: Reduces one step

Full screen

3. Toresize at an angle, select the appropriate icon from the menu (below left).
The direction of resizing is explained below right:

m Enlarge north-east

[ Enlarge south-east
- B Enlarge south-west
Eahgemrhﬂst
[ Reduce north-east
| Reduce south-east
[ Reduce south-west
M Reduce north-west

Resize panel

Cameras Full screen

i. Enable or lock against automatic display switching

What is “display-switching”?

This is when automated system actions change the graphical user interface unexpectedly.

For example, while an operator is working in the interface, a “switch display event action” may suddenly
display a Live camera view that takes over the entire cameras desktop.

005-20120711-05 Rev 2 www.cathexis.co.za Page 11
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e To stop automated system display- e To enable automated system display-

switching of the operator interface switching of the operator interface
Click the Lock icon a at bottom right of your Click the Lock icon () at bottom right of your
CatVision screen, and select “Lock display”: CatVision screen, and select “Unlock display”:
i | — [ |
i Lock display i Unlock display

Settings... 1 Settings...

> The icon will change to denote “Locked” t > The icon will change to denote “Unlocked” a

j. Manually Record Video (User Recordings)

Start the Recording

Middle Click on a camera in the Cameras Tab and you should see >t ecerding o5 an ption in the drop down
Menu. Click this to start the recording. If the recording has started you should get a flashing H& E in the top
right hand corner of the camera panel.

Stop the Recording
To stop the recording middle-click on the camera panel and click on >tep recerding in the drop-down menu.

Note: you may only trigger one camera at a time.

005-20120711-05 Rev 2 www.cathexis.co.za Page 12
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2 PTZ / dome camera procedures

With a Pan-Tilt-Zoom (PTZ) camera an operator can manipulate the camera's direction, zoom, focal distance
and amount of light. He / she can also control pre-configured camera views called “Presets”.

A Dome Control Panel becomes available when you select a Live PTZ camera in the CatVision interface.

Click the panels dropdown and select PTZ (see below). The software joystick displays:

Preset 01 [=] T
(EnED

This panel provides controls for camera presets, and a software
joystick for interactive control of the camera.

The Preset controls enable you to set Presets and go to Presets.

The curved grey buttons surrounding the joystick enable zooming in
and out, focussing closer or further away, and iris control — lightening
or darkening the camera image.

The Manual button is for manual override of the dome (to override
automated patterns, local tours etc). The Auto button relinquishes
manual control, to let the system regain its automated configuration.

Note the green text on one of these buttons. This indicates which
mode currently applies — - or - In the example at left, the
system can function automatically. The screen may change
unexpectedly as it runs patterns, tours, etc.

IMPORTANT: If you cannot see this panel as an option, either you do not have a PTZ/dome camera selected,
or the camera has not been properly configured as a dome/PTZ.

e PTZ Panel

To pan left / right from the PTZ panel To tilt up / down from the PTZ panel

&) (3% Dragjoystick left / right

5 Q Drag joystick up / down

To move the camera faster from the PTZ To move the camera slower from the PTZ
panel panel

Cen Distance determines speed - drag joystick Cee Distance determines speed - drag joystick
out, in required direction closer in, in required direction

To zoom in / out from the PTZ panel To focus further / closer from the PTZ panel
Watch the live camera as you press the Zoom + Watch the live camera as you press the Focus + and

and Zoom - button

Focus - button

005-20120711-05 Rev 2
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To go to a preset from the PTZ panel

Select the preset from the dropdown, and then
click GO

> The camera view will change to the preset.

To set a preset from the PTZ panel
1. Select the preset from the dropdown,

2. Use the joystick controls to establish the camera
view, zoom, focus and light (iris).

3. Click SET.
4. Go to this preset to check it.

To relinquish manual control of the dome /
PTZ camera from the PTZ panel
Click Auto. > If your system runs remote tours

automatically, or switches display based on events,
these automated responses will take over.

Pause a PTZ Tour

PTZ tours can be paused/restarted, per camera. This
is achieved by right-clicking on the camera in the
resource panel and selecting the "Pause/restart PTZ
tours" option.

To lighten/darken the live camera view from
the PTZ panel

Watch the live camera as you press the iris+, or iris
— button. You will see the image lighten or darken

To gain manual control of the dome / PTZ
camera from the PTZ panel

(This applies if you system runs remote tours
automatically, or switches display based on events)

Either click manual, or simply move the software
joystick

e (Camera Panel Zoom Options

Note: If the camera supports any of the above then
control using the icons on the bottom-left of the screen

you can switch between digital and PTZ

Zoom In/Out

Scroll the mouse wheel. Holding down the shift key
while scrolling the mouse wheel will do an
accelerated zoom

Zoom to Area

Holding the shift key select an area using the left
mouse button

Zoom out completely

Press the Z key or; hold the left mouse-button
down, for half a second, and select the zoom out
menu option

Center on Point
Holding the shift key press the left mouse button; or
Hold the left mouse-button down, for half a second,

and select the center on point menu option.

005-20120711-05 Rev 2
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a. Review (replay) a camera

e To Review a camera from the video wall by means of overlaid controls

Hold your cursor bottom
centre to displaythe
Replaycontrols

1. Hold the mouse cursor at the bottom middle of the
camera panel to display the Replay controls.

2. Use the replay buttons as follows:

Start frame | Rewind | 1-frame back | Pause | 1-frame
forward | Play | End frame

e To review a camera from the Camera control bar

These controls can replay 1x camera, or, up to 8x selected cameras (synchronized).

— Go to first recorded frame
— Play backwards
— Step backwards
— Pause
Step forwards
Play forwards

Gota Time

(Mcjafujpnirn@) &

Goto last recorded frame

Replay speed control

|—Go Live

Lock or unlock
interface far auta
display-switching

Tagged area aof
primary timeline

Primary timeline

-] a

(%00) 15/03/2005 09:57:18
L I— Start tag date/time
View start frame

- Starttag

{I] 19/09/2005 11:13:23 (00 | M| B )
End tag dateftime J J J

Yiew end frame

Tagged area of primary timeline Endtag

Clear tags
Archive tagged content

Camera controls closely follow the VCR norm. Cameras can be viewed Live and Reviewed within the same
display.

Replay speed: set this at a multiple of normal speed (0.2x, 0.5x, m, 2x, 5x, 10x, 100x)

See Display-switching (pg 11) for procedures to enable or lock against automated system switching of the
interface display.

b. Print a snapshot
e To print a snapshot from the CatVision Resources desktop

The DSS printer must have been be setup from the catlLite / catPro interface.

1. Middle-Mouse Click, and select “Print snapshot” (On camera review, first pause the replay at the image that
you want)

->The standard print dialogue displays
2. Print normally to the printer.
->The printed image includes information on the DSS Unit, Camera name, Snapshot Time, and Print Time:
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Snapshot Printout TIP: With the Adobe Writer, you can print to .pdf files, and then
Demo Unit email the files

Camera; H264 05
Snapshot Time:  18/012000 10:02:38, 160
Print Time: 15/01/2009 03:57:30

[ —

c. Use the CLIPBOARD to snapshot, print and export camera images

Edit View Site Layou CatVision has three snapshot options:
[[¥ Show Clipboard e Copy snapshot to Clipboard
[% Clear Clipboard e Print snapshot

e Save snapshot image to USB — this saved JPEG file is the image only,
without the date/time

e To print a snapshot e To show the clipboard e To clear the
with date/time clipboard
reference
Copy the snapshot to the . ') . 0
[Zelli > Sh lipboard =~ i i o
clipboard, and print from there, I ow cliphoar s > Clear clipboard
or Clipboard holds images that have Clears all images from the
Print the snapshot directly from been manually snapshotted from clipboard
. cameras. For use generally, and
CatVision. ] .
with the Incident Database.
Double-click to display an image.

e To export an image from the clipboard to a folder

1. Open the clipboard in the CatVision interface: click > Show Clipboard
2. Right click the photo and click Save as...

Media Clipboard

2012/06/05
10:4345PTZ

View...
Print...
Save As...

Clear

Clear All

10

2012/06/05
10:38:57 stairs

3. Browse to the appropriate folder, type a File name and click Save.

e To print a snapshot

1. Open the clipboard in the CatVision interface: click > Show Clipboard
2. Right click the thumbnail and click Print...
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e To export an image from a camera view

1. Middle-Mouse click any camera in the CatVision interface and select Save snapshot...

Copy snapshot to clipboard »

Print snapshot 3

Original image

Format Displayed image

-

2. Browse to the appropriate folder, type a File name, and click Save:
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4 Layouts and Sequences (Video Wall Menu)

a. Video Wall

Videowall Tools Settings Help In pre-5403b software this menu was titled the Layout Menu, and
only contained setup information for Layouts.

Recall layout 3

o

Creat | t... . .
reate newiayed A Layout defines how the cameras appear on the screen, in the

Cameras Tab. Including which cameras are shown, and how much
Recall sequence - space they take up on the screen.

Owerwrite layout 3

Manage layouts...

o P | B2 7

A Sequence is a cycle of individual cameras that will run, on a timer,

Manage sequences... ] ! T .
in a single viewing pane, in the Cameras Tab.

Resize layout...
The Switch Display Settings for this tab will define the behaviour of
the currently open Cameras Tab, when video information is sent to
the Client Station with an alarm.

Switch display settings for this tab...

Note: this menu option will only be present when you are viewing a Cameras Tab.

Layout

A Layout defines how the cameras appear on the screen, in the Cameras Tab. Including which cameras are
shown, and how much space they take up on the screen.

e C(Create new Layout

To create a layout, organise your cameras on the screen as you desire (double-left-click to expand; single-right-

click to reduce). Then click on —>New. Give the Layout a name, and click OK. (you can use Layouts
created in the Cameras Tab in the Monitors Tab, and Visa Versa.)

e Recall a Layout

]

To bring up a list of existing Layouts, click on @ Recall and select the layout name that you desire.

e Overwrite Layout

Clicking on b Overwrite , and selecting on one of the Layouts in the list, will overwrite that Layout with

the current panel organisation.

e Manage Layouts

Clicking on G Manage iy bring up the list of existing
Layouts for you to manage.

From the management list you may either delete the Layout
or enter the Layout Properties window.

These are both done by right-clicking on the Layout in the

list.
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Properti In the Layout Properties window you may change the
Name, and User ID of the Layout, as well as the User Access
Name |50 Level required to view, or edit, the layout.
User D

Note: if you have limited access rights, you won’t be able to
Access rights change these settings.

| [ Levell [7] Level2 [7] Level 3

e Resize Layout

Resize layout...

Clicking on will give you the ability to change how many
cameras are arranged on the screen.

Height 4 = You may define how many cameras there are per row, and per column.

[ oK ] ’ Cancel The maximum amount of cameras you may have per screen will be an 8*8
matrix. This gives you a possible 64 cameras per Layout. (This would
require an incredibly large screen to be practical though.)

Sequence

A Sequence is a cycle of individual cameras that will run, on a timer, in a single viewing pane.

e Sequence Manager

E;.- Salvo Manager m
Clicking on the == icon will bring up the

2B 2 cameras and Just fuds Sequence Manager.
To edit a Sequence, select the existing

Sequence and click Edit. To create a new
Sequence click on New. This will bring up
[ New J ’ Delete ] ’ Edit ] ’ Ok the Sequence Editor.

e Sequence Editor

You may access the Sequence Editor, where you can create and edit sequences, via the Sequence Manager.

s o I S5 Name your Seaence appropriately.

I Name || Should lecp
The left hand panel will hold a list of
Camera Duration Dome command .
available cameras.
The right hand panel will hold a list of
B (o e cameras that are included in the
— Sequence.

Sequence Editor Procedures

Add a camera to a Sequence | You may:
-double-click on a camera in the list of available cameras.
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-Or click-drag one, or multiple cameras, across into the Sequence list.

Remove a camera

Right-click on the camera and select Delete.

Set the duration of a camera
for each loop of the
Sequence

-Right-click, and select Set Duration.
-Enter the duration in seconds, and click OK.

Looping

If the Shouldloop o ption is checked the Sequence will run indefinitely, if it is
unchecked the Sequence will run once.

Change the order

order.

Select a camera and use the arrows to move that camera up or down the

e Recall Sequence

To recall an existing sequence click on

the sequence you wish to run.

Switch Display Settings

& Recall sequence

to bring up a list of all existing sequences. Click on

This will define how your cameras tab responds when there is an event on the site that sends video and
information to the Cameras Tab of the viewing client.

Note: The Switch Display Settings that you set here are for the currently open tab only

Switch display
Configure switch display settings for new tabs

[] Lock display

Don't restore display

[] Criy switch local cameras

@ Restore display after | 30sec =

0K

|| cancel

Lock Display
Will prevent the Cameras Tab from displaying any video
feeds sent to it by the Event.

Restore display after
Will define how long after switching to the Event Cameras
the Cameras Tab will return to the original display settings.

Don’t restore display
Will leave the Cameras Tab on the Event Cameras until an
operator, or administrator, resets the display.

Only Switch Local Cameras
Will only switch to Event cameras originating from a local
site.

Note: you may also either Iockli', or unlock |I"|, the currently opened Cameras Tab by clicking on the little lock
located at the end of the Timeline on the Review Controls.

005-20120711-05 Rev 2
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s Archiving

a. Archive recordings

L Archived recordings retain their “Authenticity”

Archiving is a facility to enable you to select recordings (including images video and text) on a DVR unit and
copy them to archiving media (USB key, hard drive or CD/DVD). Unlike normal recordings, archived recordings
retain their authenticity, and can be verified as authentic (unaltered) on replay, making them suitable for use
in courts of law.

e To archive recordings

1. Left click to select a camera (or select multiple cameras by means of CTRL-leftclick)

> The camera/s will be highlighted in red.
|| 1mam15ﬁm_w||

(MJJafu]e]»n[@) & (]
) oo ()

2. Locate an image to set the start tag position of your archive, by either

I.  Dragging the scrollbar 0.
Il. Using the camera controls L4 lanjw|» »]

Ill. Doing a time/date search EJ
3. When you have found your starting image, click the Start tag button 3.
4. Locate an image to set the end-tag position by either.
I.  Dragging the scrollbar m__
Il. Doing atime/date search @J
5. When you have found your end image, click the End-Tag button l?u
> A partial blue line appears on the main scroll bar, representing the tagged selection of recordings.

b @,"-, X (1} Simultaneously, a second blue “tagged scroll
. "ﬂ : I“LI bar” appears beneath the main scroll bar.

@ 11/07/200713:42350  \\hereas the top bar represents all recordings,
this second bar represents just your selected
recordings.

P = When the scroll button on the main (top) scroll

” { ‘) | * | S . . . .

bl AV 1 bar is not in its blue area (as at left), there will

11/07/2007 091220  be no interactivity possible on the tagged
(bottom) scroll bar.

—

A
6. Click the Archive button *Q-’
> An Archive window appears:
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.
Archive @

Local disk (=]
Archive location | CAarchive 2\ @

Total archive size |12 MB

Progress

[] Copy catPlayer

|Waiting for user to start archive |

Cancel Meat >

7. Tick Copy catPlayer if you want to include catPlayer in the folder (this copies the autorun catPlayer files and
the catPlayer .exe file into the folder).

NOTE: If you “Copy catPlayer” for every archive into different folders, you may be wasting hard drive space.
9. Click the Browse button & to display the Find Directory Window:
@ Find Directory |§|‘

Lookin: [CyCrachive [v] 4= (&) ok [l

. | shaders

L. forts

| icons

.

File type: [ Directories J Cancel

IMPORTANT: Your system administrator may have limited you to archiving in a single folder location.

10. Either browse for an existing folder, and then click OK, or Create a New folder:

10.1. Click the Create New Folder button E¥.
> A new folder is created, and you are prompted to name it:

Ll

Lockin 3 € idvarivchivn of Smtch Thelt/ EHeme@Em
Dirmctory; | Pew Foider 1
N T [ ]

10.2. Type a name for the folder.
10.3. Double-click the folder so that it opens.
[Although you can create a folder, you cannot custom-name the archive itself]
11. Click OK and then click Next.
> You will see a status display of the progress, including:
| Archive [z

[ Local disk =]

Archive location | Charchive 24 |i‘

Total archive size | 12 MB

Progress

| TS

[/] Copy catPlayer
| Fetch and write |

12. When you see “Archive complete”, click the Close button.

005-20120711-05 Rev 2 www.cathexis.co.za Page 22



http://www.cathexis.co.za/

b. Replay archived recordings

Two means of replaying archived recordings:

There are two means of replaying archived recordings: 1) Windows catPlayer archive player, and 2) the Archive
Player desktop in CatVision. The functionality is almost identical.

o Windows catPlayer archive player

Click Start>Programs>Cathexis> catPlayer £

The Windows catPlayer software has a means of verifying and reporting on the authenticity of the archive or
image. The catPlayer utilizes DSA 1024 bit encryption. At the time of archiving, the DVR performs a
mathematical hash function on the file. When verified by means of the catPlayer on the local windows PC, the
same hash function is again run on the file, and if the result is different in any way (even if a single pixel has
been changed) the file is rejected as unauthentic. Windows catPlayer archive-player software can be optionally
copied into the archive folder with each archiving action.

e Archive Viewer desktop in CatVision

T  The Archive Player is incorporated as an “Archive viewer” desktop within CatVision
Open site 3 software.
'@; Enterprise manager

it It has the same functionality as the Windows catPlayer, except that it is possible to
ulti-site view

export archived content from this desktop to AVI format that can be played in many
commercial / popular software programs.

TesthVR ’

€ Quit
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c. Archive Player / Viewer interface

Menu Options in Menu Options in
catPlayer catSite Archive player

Archive Tools Settings

[l Select directory ] Select directory
ﬁ Open local backup ﬁ Open local backup

Quit
atPlayer tab (in catSite this will be one of many tabs)
Archives Menu (to open archives) Current Control Panel
2 catSite (1) - = B =
File Edit View Archive Tools Settings Help DO
= Event List =
Middle Mouse Button Event Listing |
Pop-Up Menu
@ Standard ) Thumbnad
13
stairs R
Maintain aspect ratio =] 2012/05/24 14:25:31
v Deinterlace
SEom detnry gf:“
v Fastest scaling =
- 2012/05/25 14:48:55
v Rectangular transform
Spherical transform o @13
Cylindrical transform 2012/05/25 14:48:55
v Show time @1-3
No camera
Archive Data can be
viewed
I Zlal~z] @
CIEREIRIIICIEO N | {0 =T Ta
e T AT FIEAEIL
A /00) 0; CoE b 36

Browse for Archives—
Open Local Backup =
Print Selected Frame—

Save Selected Frame —

Verify as Authentic s——

— Go to first recorded frame
— Play backwards

—Step backwards
Pause

Step forwards
Play forwards
Go to last recorded frame
Go to Time

I_Replay speed control Tagged area of primary imeline

Primary timeline

r

e anp »nE) {|]
“4 GG 13/09/2005 09:57:18 @ 19/09/2005 111323 OO W W &9
I_ L Start tag date/time End tag dateftime J J
View start frame View end frame
L. Start tag Tagged area of primary timeline End tag
Clear tags

Archive tagged content

d. How to use the Archive Player / Viewer

e To browse for archived data in a folder of archives

Click the > Select Directory icon to specify a
i) Select Owectory folder of archives (on hard drive, CD/DVD or USB), or

Lookin: (¥ [+] = &

b ..
. forts
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(@) [¢)

E‘ 15/09/2005 10:42:00
T Input Dev Entrance
H i s

e Standard Event List
sorts Events by date/time

Ml !

Click the Browse for archives button, or

Click the Open local backup icon to locate a local
backup drive

Cameras

> Individual archives have automated names such as 051007154908_0051BB04_011.WVL

> The system lists all valid archives/backups in the Cameras or Event List panel on the right of the main
screen, depending which you have selected...

|

Available Cameras

E 14/09/2005 10:43:59

e Thumbnail Event List
displays 1** frame of each
recording

Event List - Event List

Eent Listing Event Listing

{* Standard 7 Thumbnail ‘ ‘ " Standard & Thumbnail

Fecoiding Hecording I

R £ DB/03/2005 16:22:19

T Input event!

i MJpeg Camera 1 ik

L 14/09/2005 104352 - Jpea
E‘ : Garage

MJpeg Camera 7

Cameras

Mtamela 1
@/ Camera 2
“Camela 7

[M Camera 10

Cameras List displays all
cameras found in the
archive folder. Drag
cameras to the desktop
for camera replay.

2012/05/24 14:25:31.328 |

uirni| \View sequential images (as above)

Example: sequential images...

144Kk

e Toreplay a recording in a floating window

View as a single pane

e \/iew

From the Event List (standard) panel, double-click an individual event item / recording, or
From the Event List (thumbnails) panel, double-click a thumbnail.
The replay window can display in three different forms:

as 4 staggered panes

| P

2012/05/24 14:25:31.368

([ falu ey [ 0@ ]

[ 2012/05/24 14:25:31.448

Cameras

-

Ll
Available Camaras

005-20120711-05 Rev 2

e To display archived data in the Archive Player / Viewer desktop

www.cathexis.co.za

From the Cameras panel, drag cameras to the desktop, or double-click
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From the Event List (standard) panel, drag individual event items
(recordings) to the desktop, or

From the Event List (thumbnails) panel, drag thumbnails to the

desktop, or

ldlierd ui

Camera 02

mera 03

Middle-click a camera panel and then select the camera from the
middle-click menu.

e To apply a lens transformation to correct
images
Right-click the
image and select

(For specific cameras that
use very high resolutions

one of the and special lenses to enable
available the camera to cover
“transforms”: an entire room without

panning. However, the lens
twists the image, so when a
user “pans and zooms” the
room during replay (actually
pans and zooms the image),
software is required to
correct the image twist.)

v Rectangular transform
Spherical transform
Cylindrical transform

e To locate a specific time in the recording
timeline

Click the Time icon, and then specify from the
Date/Time dialogue:

6 | June [«]2012 ¢ |os (37 3 5
=
or,
= .
= 10/9/2005130617 1 Drag the slider along the

timeline until you reach the
appropriate date/time. As you
drag, a “callout” displays
date/time.

_@—

e To verify an event as authentic (i.e.
unmodified)

Select a specific Event (not a generalised camera
review), and then Click the Verify icon 'ﬁ

> A window displays, with verification or non-
verification information:

Event

Time: 2012/05/24 14:25:31 i
Camera: 64 *
Status:

Event verified successfully
ltem is authentic

( oK J

This does not function with a camera review —
you must select a specific event from the event
list or from a camera display of a specific event.

e To browse a long Event list

Use the browse buttons at the bottom of the Event
List panel:

e To change the camera display size

inj

tJ_ Right-click to change from 1 camera to
4 camera.

Double-click to change from 4 camera
to 1 camera.

e. Export archived Events and tagged regions as AVI files (from CatVision)

1. Overview

This enables the user to view archived video footage in standard AVI format, using standard video players.

The procedure involves exporting the standard archiving footage to AVI (Multimedia container format) using

WMV compression.

005-20120711-05 Rev 2
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Software that can play WMV files includes Windows Media Player, GOM Player, ALLPlayer, The KMPlayer,
PowerDVD, RealPlayer, MPlayer, VLC Media Player, Zoom Player and Media Player Classic.

The Microsoft Zune media management software supports the WMV codec, but uses a Zune-specific variation

of Windows Media DRM which is used by PlaysForSure. Many third-party players exist for various platforms
such as Linux that use the FFmpeg implementation of the WMV codecs.

Reqguirements

To export to an AVI file, you need to already have archived the footage (using the standard archiving
procedure) and have opened the footage via the Archive Viewer desktop.

From the Archive Viewer there are two ways to archive the footage: 1) By means of the Event List or 2) by
tagging a region. Both procedures are described below.

e To export media to AVI via the Event List

1. Open the Event List as follows:
= Cameras (]
@ Cameras ‘

5] Event List_|
13

2. Right-click the event and choose the export option that you require from the drop down menu.
= Event List ]

Event Listing

@ Standard (=) Thumbnail

Recording
= 2012/05/24 14:25:31

Archive Information

S
Export to Archive..
@ ahivero CD/DVD...

5 om2/05725 1A ATSS

@13

> This will open a file browser:

s ==

Lookin: |5 C-/dvs/ =] « @ e EE=
k. | fimware 1 layouts_4Ir | streamhistory
1 Irdparty | fonts \/MNewFolder 1 [ tmp
1 Archive of Switch Theft | gnupg 1/ MNew Folder2 | translations
1 Archives General 1 help | profdata 1 viewer
i bin 1. htmidoc . report_images | work
1 buffer . icons | settings
L cslir Licons_dr | shaders
1 cygwin licons_gui | stecorfig
1 dumps | keys 1 sitedh
1 files 1 layouts | sounds
Fietype: | AVl Video ("avi) [=] Cancel

3. Browse for a folder and click the “Save” button.
> The conversion (from the standard archiving format to AVI) will start, and will indicate when exporting is
completed:

<7 Export complete.

" Exporting video data...
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e To export to AVI by means of a tagged region

1. Tag a specific selection by using the toolbar at the bottom of the archive player:
Export zone to AVI

Clear tags

Pin/tag endi oint
Pinftag starting point inftag ending poi

Time line Preview last frame
Preview first frame

ad-" 19/02/2009 15:27:18 [D 19/02/2003 15:27:23 '::09

2. With the region successfully tagged, click the Export zone to AVI button.
> This will open a file browser.

3. Save the file to a folder and click the ”Save” button:

B ]
Lookin: |3 C:/dvs/ [«] & @ e
W .. . firmware | layouts_4ir |/ streamhistory I
| Irdparty | fonts | New Folder 1 . tmp
|| Archive of Switch Theft | gnupg |/ Mew Folder2 || translations
|| Archives General |/ help | profdata | viewer
L bin | htmidoc |Jreport_mages . work
| buffer | icons | settings
cslr \icons_dIr | shaders
| cygwin \.icons_gui | steconfig
| dumps | keys | sitedb
L files |/ layouts |/ sounds
File type: | AVI Video ("avi) [+] Cangel

> The conversion (from the standard archiving format to AVI) will start and will indicate when exporting is
completed:

! Encoding video data... (31%) < Export complete

™ Exporting video data... |
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6 Database Tab

a. Database Tab

¢ Edit View Site Tools Settings Help

[=] Matthew's Ste 1 |[ZVitual VR 5 |75 See ks

=
== VMD database @
| B Access Cat Tech assembiy 2(Z 2013/06/11 162316
38 Coddx DB Cat Tach Shding (Zone  2013/06/11 14:23.25 , @
_ Outside Rear PTZ { Zone 2013/06/11 14:23:33 List of Database
List of Outside Rear PTZ { Zone 2013/06/11 14:2354 Entries
Databases St Lo, oo AL e
Cat Tech Admin area (Z 2012/06/11 14:24:59
Cat Aica Storage (Zo  2013/06/11 14:25:23
Cat Tech Admin area (Z 2013/06/11 14:25:30
Cat Tach assembly 1 (Zo 2013/06/11 14:25:41
Cat Tech Admin area (2 2013/06/11 14:25.50
Cat Arica Consign (Fon  2013/06/11 14:2551
Cal Tech Skiding (Fone  2013/06/11 14:26:18
Cat Tech assembly 2(Z 2012/06/11 14:26:40
| Cat Mrca Storage (Zo  2013/06/11 14:26:45

g calcentuionsecuty B

neeal

index  Resource Type

f 56  Cat Techassembly 1 (Zone 5) VIDEOSTREAM

Details of Selected
Database Entry

Connected 1o unt Centurion access comil - UNit Connected To B & v

matt Administrator & Online

Site Tools Settings He To open the CatVision Database Tab select Site—>Open Tab—

>Databases
. E| Carneras

ﬁ% Close site's tabs
@ Change password...

b. Replay a Recording

To replay a recording that has been associated with a database entry, simply double click on the relevant
entry.

Replay as a Stepped Strip, or a Single Image.

You may play your replay as a strip that is stepped by four frames, this is useful for comparison between

frames, as you may have four sequential frames visible at all times. Click on g for stepped replay, and click
P

on ==l for single pane replay.

In both instances the date and time of the current frame will be listed in the grey bar under the frame.
| 2013706411 14:31:46.395
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e Playback Controls

Go To First Recorded Frame
Rewind

Step Backwards One Fram
r Playback

|_Pa“5e Speed
K 12 e

|—Se|ect a Specific Time
Step Forward One Frame

Play Forward
Step Forwards One Frame

c. Do a Time Search

1. Inthe Database Tab, click on the icon, located in the bottom right hand corner.
2. Select the date and time:

= - ™ £y £ DK
11 2 | June [=]2m3 |2 06 =)||40 il ~land cllck

The list of database entries will have been pared down to beginning with the event closest to the time you
selected, and a few subsequent entries.

d. Filter a database to Locate recordings?

While the time-filtering is useful, CatVision provides for far more powerful filtering of databases. There are
three major filter types: Filters, Field Constraints, and Time Constraints.

Note: All filtering is based on AND/OR options.

AND If you apply Filter A AND Filter B, the result will contain only those Events in which both Filter A and
Filter B are true.

OR If you apply Filter A OR Filter B, the result will contain any Event in which Filter A is true, plus any Event
in which Filter B is true.

Note however that within a single filter you cannot use both functions — so you cannot apply “Filter A AND
Filter B OR Filter C”. (It must either be all AND filters or all OR filters.)

e Add/Remove a Filter

Click on % to add a filter.
Click on g to remove a filter.

e Enable a Filter

B s e e In order to have any of the Filters active you need to check the

relevant filter box at the bottom of the filters dialogue.
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Note: you may further constrain results, by making Filters and Field Constraints AND/OR dependant. For

example you may have a search that requires that the Eventmustmatchfiters gr field constraints o v 6y may have
it set so that the Event must match fiters zny field constraints

Filters Tab

If event These are the primary sorting lists. The blue underlined style indicates that they are options.
has camera | Click to see a pop-up list of the options. You can choose from the following:

Cameran Has camera > (then choose camera from Camera Name dropdown list)
Has audio > (then choose audio input from Audio Input Name dropdown list)
Is tagged

This is a logical parameter for multiple filters. It may be “and” or “or”. It only appears if you
have more than one filter. By default it is “and”.

The filter results must match all of the filters. For example, if we have
% f event & fsoged and

g ff event fizs camers  Caf Tech Siding Zone 788 and

Q
>
o

g f event fas aud O Teoh Sidng Fone 748)

and Then the result is only those Events that are Tagged, that also include Camera 5
- content, and that also include Audio Input 3 content — probably a short list.

The filter results must match any of the filters. For example, if we have
% I event hzs camem O Tech Siding Fone 788 or

%Heuerﬂ Ef ar
or

% Fevent fas audic O Tech Shding (Fone 748)

Then the result is all events with Camera 5 content plus all Events that are tagged
plus all events that have Audio Input 3 content — probably a long list.

Field Constraints Tab

This tab is only visible if you have a streaming text data application installed, in which case you see these text
data field filters. They include the fields that have been identified in the text data streaming setup. i.e. on this
tab you will see the fields that you have customised for the text data application.

Examples of text data are the data streamed from till transactions (transaction number, purchase amount,
time, number of purchased items, etc.), and data streamed from Access Control applications (name, time,
employee number, etc.). This data is stored as different “fields”. It is possible to constrain filtered results based
on various decisions with these fields.

The principle remains the same as the Filters tab, where you create a filter and then change its parameters
using dropdown options (see above). The nature of these parameters depends entirely on your custom
application.

Time Constraints Tab

There are a number of different ways to constrain the time these are:
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equal to

greater than

greater than or equal to
less than

less than or equal to

between (inclusive)

between (exclusive)

Note: to modify the times click on the Date/Time hyperlink and enter in your parameters in the dialogue that
pops up.

i :
e. Archive Selected Database Recordings =

If you wish to save a particular Database entry for later viewing, or to prevent an important piece of

=
information from being overwritten, you may archive it. To archive a selected Database Entry click on the
icon.

7 Archive H‘ z; L8 838  The archive interface will tell

you where the archive will be

Loesidee =] created, and allow you to define

Archive location | C:\Program Files (86)"Cathexds catVision Suite WRW\archives“Johnny's Power Supply™ @ your own archive location.

Total archive size [2 MB |

You will also see the total

e archive size that the Archive will

- . take.

[ Copy catPlayer The progress bar will indicate

| Wating for user to stat archive | how far along the archives
creation is.

Cancel || MNext> |

The [C] Cepy catPlayer option exists because the archived recording, for authenticity purposes may only be
played back using CatVision’s archive player (which comes with all installations of the CatVision suite). If you
are going to be playing the archive on a computer that does not have the CatVision suite, you may check this
option, and an archive player will be included in the archive’s folder.

e Archive multiple Database Entries
To archive multiple Database entries simply Ctrl-Click, or Shift-Click, the entries that you wish to archive, and

follow the procedure outlined above.

f. Print an Image from a Video Replay

To print a specific frame from video replay, you may right click anywhere on the on the image, and select print.
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7 Monitors Tab

The monitors tab is a tab that gives you full control over the Video Wall. Here you can change the layout, and
define camera Sequences, and salvos.

You will not see any video playing on the interface. You will see the names of cameras where they are placed
in the layout.

Moritors  |[] Matthew's Sie 3¢ |§§ Matthew's Ste 3¢ —

7 Matthew's Site #]

- @ass
@, Doorway
woidsf

0 Mo camera

e Mo camera

e Mo camera Q Mo camera

B EE DB

'3 Dioorw oy

0 Mo camera Q Mo camera

Wafafnjw|v[M[O) o &

Open a Site on a Screen

The list of monitors that you see will be representative of the number of monitors that have been added to
servers on the site.

To Open a monitor from a site, select one of the available
Monitors. Then click the Sites list:

o Matthew's Ste B

Second Mondlor

Matthew's Sae

Then select your site.
The Monitor with a red border will be the Monitor whose camera Layout is displayed below it.

Layout

A layout defines how the cameras appear on the screen. This includes which cameras are present, to how
much of the screen an individual camera takes up.

Recall a Layout
To bring up a particular layout on a screen, click on the icon, and select the layout name that you
desire. The Layout
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Sequence

A Sequence will run a set of cameras, in single camera panel.

Run a Sequence - Click on a camera panel.

- Click on'—

- Select the relevent Sequence from the drop down menu.

Salvo

A Salvo is a set of Layouts. This means that the Layout of cameras on the monitor will change, running through
a set order, using the pre-defined Layouts.

Run a Salvo - Click on a Layout panel.

- Click on

- Select the relevent Salvo from the drop down menu.

Virtual Cameras interface

The virtual cameras interface is the

interface where you

Q Mo camera Q Mo camera

e See the Layout that the cameras
will take on the Monitor that you
have selected.

@ Nocamers @ Mo camers e See what cameras are in which
panels.

e May control the overlays on
each camera

o And use the Playback controls to
review video on the Monitor.

'a' Mo camera e Mo camera

|3 D

QonvEy

'a' Mo camera e Mo camera

M laln > M[E) =] %

e Individual Panel Settings

To change the settings of an individual panel middle-click on the panel, this will bring up the following menu:

Set no camera Set No Camera will make this panel blank

Review camera This will bring up the recordings of the selected camera. For information on reviewing the
camera see the section below, on Review Controls

Mext video format | This will cycle through the available video feeds that are available on the selected camera.
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e Review Controls

~ Go to first recorded frame
- Play backwards
~Step backwards
~ Pause

- Step forwards
Play forwards

Go to last recorded frame
Go to Time

Replay speed control

[ I—Go Live

MdJajufn[»[n[®) g &
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8 Audio procedures

m A microphone and speaker on the menu bar (at the top right of the screen) represent your two
local audio hardware resources, local audio input and local audio output.

These two icons represent the state of your local microphone and speaker - when a resource is being used, its
icon is bright - in colour, and when the resource is inactive, its icon is grey.

You can look at these icons to see the current state of audio interaction, and you can run your mouse cursor
over a - icon for information on the activity. However, the actual control of audio is from icons in the
Resource Panel and Live remote cameras:

e To listen to a remote site by means of the Resource panel

Open the Resource panel for the remote site, and double-click the remote microphone that you wish to listen
to.

> Your local speaker goes green , indicating that your listening is in progress. If you move the cursor over the
speaker, you will see a tool-tip describing the remote audio input that is being listened to. You should hear
sound from the remote site.

e To stop listening to a remote site by means of the Resource panel

Right click your local speaker, and choose Stop.

> Your local speaker goes grey, indicating that your listening is no longer in progress.

e To listen to remote Live MPEG by means of the middle-click camera menu

A Live remote MPEG camera with audio will display a small
microphone icon before the name on the camera display:

Middle-click the camera image, and select Listen from the menu.

> You will see the icon change from grey to green, to indicate activity. You should also hear sound on your local
speaker

e To stop listening to remote Live MPEG by means of the middle-click camera menu

Middle-click the camera image, and select Stop listening from the menu.

> You will see the icon change from green to grey, to indicate inactivity. Sound should stop on your local
speaker

e To speak to a remote site

Open the Resource panel for the remote site, and double-click the remote speaker that you wish to speak
through.

> Your local microphone goes green, indicating that your speaking is in progress.
e To stop speaking to a remote site

Right click your local microphone, and choose Stop call.

> Your local microphone goes grey, indicating that your speaking is no longer in progress.
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9 Other procedures

e To switch a relay output (e.g. unlock a door, activate a siren)

Relay outputs can also be switched from the Map (right-click>Set Output / Clear Output).

The action performed when double-clicking a relay in the CatVision resource panel is configurable. The setting
is in CatVision menu->Settings->General

=
1. l\'“} Left double-click to toggle the relay between set and clear, or
Right-click the relay.

> A popup menu offers you the choice of Set output (activate it) or Pulse Output (activate it for the period
of time that has been configured in catPro Relay Outputs setup).

2. Select an option and click OK.

>The relay changes state, and the output changes colour @ . While active the play pause image in the
middle of the Output icon will change from black to white.

3. To clear a set relay, left double-click or right-click >Clear output

e To pulse a relay output (e.g. unlock a door for a defined 4-second period)

Relay outputs can also be pulsed from the Map (right-click>Pulse Output).

e
I"'“;I Right-click the output and select Pulse output.

> This pulses the output for the time that has been set at the unit (this time is set via catPro interface: Main
Menu>System Setup>Relay Outputs). While the output is pulsed the play pause image in the middle of the
Output icon will change from black to white, when it resets it will return to black.

e To manually trigger a Site Action

This requires 1) Site action setup 2) Assignment of site action to resources pane 3) Appropriate access rights

Right-click the Site Action in the Resources Pane and then click Execute.

® Output Puise [ pecute |
=

aviz 1 Lmn

e To Manually Trigger a Recording

If User Recording has been setup in the Setup Tab (Site—>Open Tab—>Setup—>Configure Servers), then all
you have to do to manually trigger a recording is to middle-click on an individual camera in the Cameras Tab.

Start the Recording

Middle Click on a camera in the Cameras Tab and you should see 2t ecording o 4 5otion in the drop down

Menu. Click this to start the recording. If the recording has started you should get a flashing e B in the top
right hand corner of the camera panel.

Stop the Recording
To stop the recording middle-click on the camera panel and click on 3tep recerding iy the drop-down menu.

Note: you may only trigger one camera at a time.
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